
Guided Reading Documentation—Copyright © 1991 by David Herren Page 1

Guided Reading

A HyperMedia Shell
by David Herren

GREEN  MOUNTAIN  MAC
Box 342, Middlebury, VT 05753

802-388-9867 (voice) 802-388-9899 (data)

Copyright © 1991 David Herren—Version 1.1d, 21 November 1991
HyperSound XCMDs © 1989 Farallon Computing

Guided Reading is a HyperCard stack whose purpose is to assist in introducing the 
intermediate foreign language student to the literature in the target language. It provides 
an easy means for the instructor to answer questions one time that she knows the 
students will ask over and again each semester. I am further hopeful that it will 
simultaneously engage the student in a way they might not otherwise be engaged. With 
very little practice, the instructor should be able to create lessons including digital 
sound, interactive video, graphics and text, designed to provide collaborative support to 
the intermediate and beginning language student as they investigate short stories, 
poetry or excerpts in the target language.

R E Q U I R E M E N T S

Guided Reading requires the following:

• Macintosh Plus or better
• HyperCard 2.0v2 or HyperCard 2.1 (preferably the latter)
• System 6.07 or better (preferably System 7.0)
• The fonts “Russian, Japanese, & Disabled”, included here
• 1 megabyte of RAM or more (2 if you’re running System 7.0)
• A hard drive1

• A MacRecorder from Farallon Computing, Inc. (optional)2

• a video disk player (optional)
• lightweight headphones or external speakers (optional)

1Actually it could be run with a two floppy system but the difficulties in working with any HyperCard Stack 
in such a configuration make things very frustrating. For developing stacks for your students, you 
absolutely require a hard drive, but the stacks could be delivered to students on a two floppy system.

2I am working on a version that will use the built-in hardware of the newer Macintoshes, but it requires a 
complete re-write and won’t be ready for a while. Also, Farallon has just sold their hypermedia stuff to 
MacroMind and so the MacRecorder may only be available from MacroMind by the time you read this. If 
you don’t want to include sound in your lessons, then of course you don’t need the MacRecorder.
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C R E A T I N G   A   L E S S O N

Step 1: If you haven’t already done so, make a copy of the Guided Reading 
stack on your hard drive. Double-click on the Guided Reading icon—
HyperCard will launch and the Guided Reading stack will open. You will 
immediately be presented with the following dialog box asking you to 
select “Student” or “Instructor”.

Step 2: Click on the “Instructor” button. You will now be presented with another 
dialog asking you for the authoring password.

As shipped, the authoring password is “tweak”, no quotation marks and 
lower case letters. Only those who correctly enter the password will be 
able to create new lessons. If the password is incorrect, Guided Reading 
will proceed as though you were a student. You may change the 
password at any time by selecting “Change password” from the “GR 
Instructor” menu, but if you do, be forewarned that even I can’t get into a 
stack if the password has been forgotten or lost.

Step 3: Once the password has been entered correctly, GR will present the 
following dialog:

Guided Reading
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I recommend that you click the “Copy it” button. GR will prompt you for a 
name for the new stack you are creating. You might want to give it a 
name such as “Chapter One” or something intuitive that your students 
will understand. The original GR stack will remain untouched. If you click 
“Just Looking”, you will be editing your original copy of GR, which is not 
advisable.

Step 4: GR will display a copyright notice which you may dismiss by clicking 
anywhere within the notice. At this point if you are creating a new lesson, 
you will want to configure this stack with the new text and supporting 
materials. While holding down the “command” key ( ) on the keyboard, ⌘
click anywhere in the field containing the word “untitled”. Guided 
Reading will select the word untitled and you may then type the name of 
the piece of literature for which you are creating a lesson. When you 
command-click again, Guided Reading records what you have just typed 
as the name of the lesson and will use it in several place throughout. In 
the following screens, I have used the name “Sample Lesson”.

Step 5: Click on the “Continue” button and you will be taken to the following 
card:
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E N T E R I N G  T H E  T E X T

Step 1: Click on the padlock icon ( ) to unlock the large white text field. This is 
where you will enter the text the students will study. The flashing 
insertion point will appear at the top of the field.

Step 2: Type or paste in the text that you wish to use. Guided Reading was 
originally designed for one paragraph of the text per card, but you can 
place as much as about 11 pages of text on each card if you prefer. If 
you would like additional cards for more text, select “New Card” from the 
“Edit” menu. You will have to unlock the text field with the padlock icon 
each time.

Step 3: When you have entered all of the text that you intend to use, you are 
ready to begin entering the supporting materials that your students will 
refer to later.

C R E A T I N G  A  G L O S S A R Y  M A N U A L L Y

A glossary can be created in one of two ways (or a combination of the two). 
If there is a particular word that you want to be absolutely certain the 
student will find glossed, you will probably want to use the manual method. 

Step 1: Hilite that word with the I-beam cursor (the fastest way is to double-click 
on the word). If there is a short phrase that you would like to gloss as a 
unit, select the whole phrase. To instruct Guided Reading to always treat 
the phrase as a unit, you must select “Group Text” from the “GL 
Instructor” menu. When you have selected the text to be glossed, and 
grouped the text if it is a phrase, you should then select “Gloss the 
selection” from the “GR Instructor” menu. You will be whisked to the 
Glossary card where you may enter the appropriate glossary entry.

Step 2: Click the return arrow ( ) to be returned to the text card. You will 

have to unlock the field again to continue (Guided Reading is careful to 
lock the field each time you leave the card so that the text can’t be 
accidently deleted).

C R E A T I N G  A  G L O S S A R Y  A U T O M A T I C A L L Y

Guided Reading will attempt to create a complete and alphabetized list of 
all the words appearing in the text. You will of course still need to enter the 
definitions or glosses of the words it identifies. The list will often be more 
detailed that you really want it to be—GR sees “This” and “this” as distinct 
words for example. Nonetheless, it is often easiest to delete words you 
don’t want than to tediously create the glossary manually as above.

Step 1: Select “Extract Vocabulary” from the “GR Instructor” menu.
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Step 2: GR will ask you if you want to delete any existing vocabulary first. If you 
have glossed any words or phrases manually, you will want to click “No”. 
Otherwise click “Yes”. GR will begin to extract all of the unique words 
which appear in the text, alphabetize them, and place them in the 
Glossary card. This will often take a long time so try not to be impatient.

Step 3: When Guided Reading has finished, it will take you to the Glossary card:

Step 4: Click on the padlock icon to unlock the glossary field. You may now 
delete any words that you don’t care to gloss—for example, in the 
screen above I might delete the words: and, of, it and not.

Step 5: Type the definitions of any words in the list you wish to retain on the 
same line immediately following the word. If you or the student wish to 
print out a list of the vocabulary, click the “Print” button.

Step 6: When you have finished glossing all the vocabulary, click the return 
arrow to return to the text.
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E X T R A C T I N G  T H E  S E N T E N C E S

Often you will want to isolate portions of the text for closer study. Guided 
Reading will automate some of this for you by breaking the text into its 
component sentences. Of course you may wish to isolate a group of 
sentences—a short dialog for example—but again it is often easier to put 
the text back together where you desire larger pieces than to take it apart 
manually.

Step 1: Select “Extract Sentences” from the “GR Instructor” menu. GR will 
attempt to isolate the individual sentences from the text and place them 
on their own cards.

Step 2: Since the only way the computer can identify a sentence is by 
examening punctuation, GR will prompt you with a list of abbreviations 
ending in a period and ask if you would like to add any. If you need to 
add any abbreviations to the list which are unique to your text, click 
“Yes”—otherwise click “No”.

Step 3: Guided Reading will ask if you would like to delete any existing sentence 
cards. You should almost always click “Yes” here. Only under very 
unusual circumstances would you retain any earlier cards, and it is 
highly advisable that you have entered all of the text you intend to use in 
the current lesson before you extract any sentences. GR will begin the 
extraction. This will often take a long time.

Step 4: When completed with the extraction, Guided Reading will prompt you to 
check the sentences to be sure there were no errors. Errors might occur 
if any punctuation existed within parenthesis, for example. If you click 
“Check” you will be taken to the first sentence card:
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C O M B I N I N G  S E N T E N C E S

If you need to collect any of the sentences together, for example a short 
dialog, you will need to copy and paste the text from one card to another. It 
is easiest to start on the card containing the first of the segments you would 
like to combine.

Step 1: Click on the padlock icon to unlock the field containing the sentence.

Step 2: Select the entire sentence being careful not to type any additional 
characters.

Step 3: Select “Copy” from the “Edit” menu.

Step 4: Select “Delete Card” from the “Edit” menu. HyperCard deletes the 
current card and the following card appears.

Step 5: Click on the padlock icon again.

Step 6: Select “Paste text” from the “Edit” menu and type the space bar. Repeat 
this operation, copying the text of the current card, deleting the current 
card, and finally pasting into the following card until the sentences you 
wish to combine are 
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complete. You may use the right and left facing arrows to navigate through all the 
sentences.

C R E A T I N G  T H E  C O L L A B O R A T I V E  M A T E R I A L S

Guided Reading provides a way to enter supporting materials for each 
sentence. These materials can consist of text, graphics, sound, and video 
segments from a video disk. To enter textual materials follow these steps:

Step 1: Click on the button “Text Hints”. A small “window” will appear. To enter 
some text there, unlock the field by clicking once again on the padlock 
icon (each time you click the padlock icon, the flashing insertion point will 
appear in the field which is now unlocked).

Step 2: Type the textual material you wish to provide to your students. You may 
enter as much as 11 pages of text. When you are finished, click “Hide 
Hints”. 

You will have noticed a new button appear when you clicked the “Text 
Hints” button called “More Help”. You may enter an additional 11 pages 
of text in the field which will appear when you click that button if you 
wish. “More Help” does not appear initially in an attempt to get the 
student to “surmise” the meaning from context. Some instructors use 
very limited “hints” in the Hints field and a more complete “explanation” 
in the More Help field. Others might include grammatical information in 
one and cultural information in another.

You may wish to provide your students with visual information in support of the 
sentence. To do so, follow these steps:

Step 1: Click the “Graphics” button. The sentence “No graphic for this card.” will 
dissolve in.

Step 2: Tear off the “Tools” menu. It becomes a tool palette.

Step 3: Use the eraser tool to erase the “No graphic for this card.” message and 
either draw you own graphic using the paint tools, or paste in a graphic 
copied from one of the many clip art collections.

Step 4: When you are finished, close the tool palette and click the “Hide 
Graphics” button and your graphic will dissolve away.

You may also provide audio information in support of the sentence. You will have 
noticed that the “Sound” button is gray or disabled when you first arrive at the card. 
Guided Reading will enable the button only if there is some sound attached to the 
current sentence. To record some digital sound for the current sentence, follow these 
steps:

Step 1: Hold down the command key ( ) and click on the “Sound” button. You ⌘
will be taken to the following card:
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The ID of the card containing the sentence you are currently working 
with will appear in the “Current Sound” field.

Step 2: You need to tell Guided Reading where you have plugged in the 
MacRecorder. Use the “Port” pop-up menu for that. I recommend that 
you use the printer port so the modem port is available for a video disk 
player. If you choose the Printer port, GR will remind you that Appletalk 
must be disabled for the MacRecorder to work in that port.

Step 3: You must now decide what “sample rate” you are going to use for the 
recording. The higher the number, the better the sound, but the larger 
the sound as well. I have found that if you use the compression features 
of the MacRecorder that you can still get a good quality recording if you 
use the 3 to 1 compression ratio. Like any recording, the quieter the 
room, the better the recording—don’t expect studio quality if you’re not in 
a studio. Use the “Sample Rate” pop-up menu to set the rate.
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Step 4: Once you’re ready to record, click on the “• Record •” button. GR will 
calculate the amount of time you have on your Macintosh for the 
recording. If you’re working on a machine with only 1 megabyte of 
memory, you won’t have much time—perhaps just a few seconds. 
Remember that if the machines you are going to deliver the lesson on 
have less memory than your development machine, that you shouldn’t 
record huge sounds since the student machines may not be able to play 
them. GR will display a dialog instructing you what to do next.

This is the tricky part. As soon as you click “Begin Recording” the 
recording will begin and you’ll see the “thermometer” in the middle of the 
screen begin to rise. That’s an indication of how far in to your available 
time you are. Remember that the available time is determined by the 
amount of memory assigned to HyperCard and not by disk space. To 
stop recording, all you have to do is move the mouse3. You may discover 
that it’s not so easy to click the “Begin Recording” button without moving 
the mouse immediately and stopping the recording, but with a little 
practice, you can do it. (Don’t drink a pot of coffee before trying this). 
When you finish the recording you may listen to it by clicking the “Play” 
button.

I have found that if the recording is bad or you just want to record it 
again, it’s easier to click the “Erase” button, followed by the return arrow 

( ). This will take you back to the sentence card where you can 

command-click on the “Sound” button again.

Step 5: When you’re satisfied with your recording, click the return arrow to return 
to the sentence card. The “Sound” button should become enabled, or 
change to black. Henceforth the student will simply click on this button to 
hear the sound you have recorded. You may repeat the above steps for 
any or all of the sentence cards.

3It seems that on the LC you have to click the mouse. I have absolutely no idea why and since I don’t 
have an LC to conduct tests, I can’t “fix” this. It may be true of other machines as well.
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If you have access to a video disk player and are fortunate enough to have discovered a 
CAV video disk that is germane to your text, you may attach video sequences to each 
sentence. Guided Reading is capable of “driving” several different models of video disk 
player, though it has only been tested using the Pioneer 6000 and Pioneer 4200 
models. I recommend the 4200 since it is the least expensive and reasonably fast. GR 
has been optimized for this player. If you own one of the other players GR supports, I 
cannot guarantee that it will work exactly the same. Even the Pioneer units behave 
differently. GR currently supports only CAV video disks (sometimes called “full featured” 
disks, but these are the disks that allow freeze frame).

The hardest part here is finding the segments that you would like to use. Once you have 
identified a segment of a CAV video disk that you would like to use, you will want to 
write down the frame numbers that correspond to the segment. This is often quite 
tedious though GR can make it easier for you. Follow these steps to attach a sequence 
to a sentence:

Step 1: Command-click on the “Video” button. It will be gray when you first arrive 
at any sentence card unless there happens to already be a sequence 
attached. You will be taken to the following card:
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Step 2: Select the type of video disk player you are using and which will be used 
by the students. At this time GR does not easily support development on 
one type of player and delivery on another. This will be addressed in a 
future version. To select the player, use the “Player” pop-up menu. Your 
video disk player must be plugged into the modem port of the Macintosh 
(this too will be addressed in a future version).

Step 3: Many video disks, particularly those for foreign languages have the 
original sound track in one channel and a simplified track in the other. 
You can select which track you would like to hear, or stereo, using the 
“Sound” pop-up menu.

Step 4: Unless you want to play the video sequence faster or slower than 
normal, select “Normal” using the “Speed” pop-up menu.

Step 5: If you already know approximately the frame number of the sequence 
you would like to use, type that number into the box labeled “From” and 
then click the “Frame Search” button.

If you are previewing the disk to find useful segments, you may use the 
buttons on this card as a remote control for the video disk player. To see 
the frame numbers of the sequences you are watching, click on the 
“Frame On” checkbox button. The frames will appear in the video 
monitor.4 When you have decided on a sequence, type the number 
corresponding to the first frame of the sequence into the “From” box.

Step 6: Type the number corresponding to the last frame of the sequence into 
the “To” box.

Step 7: Test your segment by clicking the “Frame Search” button. The disk 
player will jump to the starting frame.

Step 8: Click the “Play till...” button and the player will play the segment, 
stopping when it reaches the frame entered in the “To” box.

If you would like to adjust the beginning or the end of the sequence a 
few frames, do so now and use the “Frame Search” and “Play till...” 
buttons to test it. You are now ready to create the sequence for the 
students.

Step 9: To have Guided Reading write the code that will control the video disk 
player, first click on the “Create a sequence for me” check box button.

Step 10: Select the audio track you would like your students to hear using the 
pop-up menu. As you click on the various buttons, 

4The first two digits refer to the chapter number. You will want to pay attention to the following numbers 
and ignore the chapters for now.
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GR will place the code in the scrolling field labeled “The Sequence”.

Step 11: The frame numbers would be a distraction to the student so click on the 
“Frame On” check box to remove the check.

Step 12: Click the “Frame Search” button.

Step 13: Click the “Play till...” button

Step 14: Now click on the “Create a sequence for me” check box button again to 
stop the creation of the sequence. You may test the sequence or clear it 
out to start again by using the appropriate buttons.

Step 15: Once you are satisfied with the sequence, click on the return arrow (

) and GR will return you to the sentence card.

Step 16: Guided Reading will ask you if you would like the sequence attached to 
the card. Click “Yes” if you are satisfied with your sequence.

G E T T I N G  H E L P

Guided Reading has a limited form of “balloon help”. If you would like help, 
just click on the question mark icon in any card and the cursor will change 
to a question mark. If there is help, small windows containing help will 
appear as you move the cursor over various parts of the window. Not all 
parts of the program are complete with respect to help though future 
versions will be more complete.

U S I N G  G U I D E D  R E A D I N G  A S  A  S T U D E N T

You will probably now want to examine your lesson to see what the student 
will see when she works with your lesson. Guided Reading does a pretty 
good job of ensuring that students can’t “accidentally” delete or change 
your work. As a result, once you enter your lesson as a student, the only 
way to re-enter as an instructor is either to quit HyperCard, or leave the GR 
lesson and re-enter it. To use the stack as a student, you may either exit 
the stack and re-enter, or you may select “Re-set the Lesson” from the “GR 
Instructor” menu. You will see all of the prompts asking you for your 
password once again and will ultimately end up at the first sentence card. 
Follow these steps to use the Guided Reading lesson as a student might:

Step 1: Enter the lesson in any fashion, to include double-clicking on the lesson 
icon in the Finder.

Step 2: Click “Student” when asked to select student or instructor.

Step 3: Dismiss the copyright notice by clicking anywhere within it.

Step 4: Click “Continue”.
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Step 5: The student will not have access to the menubar and will have to 
navigate using the buttons on the cards. The student may read the text, 
scrolling through the text on any single card, or, using the right or left 
arrows, navigating through the text cards.

Step 6: To see the glossary  if one exists of any word, either:

• double-click on the word or phrase, or
• command-click on the word or phrase.

GR will take you to the Glossary card and box the word or phrase if a 
gloss exists for that word. Otherwise it will inform you that no gloss 
exists. Click the return arrow to return to the text.

Step 7: To study any sentence more closely, click anywhere within the scrolling 
text field. Guided Reading will prompt you with instructions:

Click “OK” to continue.

Step 8: The cursor will change to an I-beam. Select the text you want to study 
and press the “Enter” key on the keyboard (not the “Return”). You need 
to select only a small portion of the text and GR will complain if you 
select too much. On the other hand, you will need to select enough text 
for it to be unique. Guided Reading will search for and find the card 
containing the text you have selected to study.

Step 9: If there is any sound attached, the “Sound” button will be black and not 
gray. You may click the “Sound” button to hear the sound.

Step 10: If there is a video sequence attached, the “Video” button will be black 
and not gray. You may click the “Video” button to see the sequence.

Step 11: You may click the “Graphics”, “Text Hints”, and/or the “More Help” 
buttons to see any other information your instructor has made available 
to you.

Step 12: Click the return arrow to return to the text.

If you would like to take any notes on the text you are studying, Guided Reading 
provides a notebook. Follow these steps to use the notebook:
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Step 1: Click the “Notebook” button and a note field will appear. It behaves much 
as a regular window. You may move it and resize it though it will respond 
more slowly than you might be accustomed to with regular windows.

Step 2: Type any notes. Guided Reading keeps your notes separate for each 
card.

Step 3: To print or save your notes, click the button “Print/Save Notes” at the 
bottom of the notes field and follow the prompts.

Step 4: To close the notes field, click in the close box in the upper left corner of 
the notes field.

Q U I T T I N G  A  G U I D E D  R E A D I N G  L E S S O N

To quit any Guided Reading lesson, click the Home icon ( ). You will be 
taken to another stack called the Home stack. Select “Quit HyperCard” 
from the “File” menu. If for some reason you don’t see a menubar, hold 
down the command key and type the spacebar.

B U G  R E P O R T I N G

( W H A T ?  Y O U  M E A N  I T ’ S  N O T  P E R F E C T ? )

Guided Reading is provided “as is” and there are no warranties either 
express or implied (after all, it is free).

It will not do anything beyond creating simple textual lessons as 
described above. It will not save you time. It will not tie your shoes. It will 
not create a new paradigm in language teaching. It may even offend 
some instructors—if so, I’m sorry. It works for some students. It doesn’t 
for others. Some learn more quickly—others don’t. I am hopeful that it 
will provide you with one more tool for engaging students in language 
learning. It “seems” to work for many of the students with whom it has 
been used. There has never been a government study to determine its 
effectiveness and I certainly wouldn’t support a tax increase to fund one.

All the above aside, I do want to see it improve. I don’t get a lot of time to 
create these kinds of things and by the time I get home from the office, 
I’m often fresh out of new ideas. If you’ve got any you’d like to share, 
contact me at one of the addresses below. Guided Reading was 
originally created as a group project with several wonderful faculty 
members at Barnard College of Columbia University. Special thanks to 
Dr. James Crapotta for arranging the workshop out of which Guided 
Reading developed. It has undergone many changes since its birth. All 
errors are mine and not Jim’s or anyone else from the workshop. I’ve 
hacked on it so much I doubt most would recognize it any longer in any 
case. If you discover any “bugs”, I definitely would like to know about 
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them. Please try to write down exactly what you were doing when you discover the 
problem. I’d be open to receiving a copy of the offending stack GR 
creates if you want to send one.

Typically if I find an error I correct it immediately. Since this is a freebie, I 
don’t send out updates to registered users, however. If you want the 
latest version, you can always send me a blank, formatted diskette with 
a return mailer and postage. I also keep the latest versions on-line on 
the Green Mountain Mac BBS (that information is below) so you could 
log on there and download it at any time. The GMMac BBS is pretty cool 
and you’d likely find some things there that are useful to you, so I 
encourage you to do that if you’ve got a modem (in all honesty, I have 
been known to let blank formatted diskettes with return mailers pile up 
for months—I always get around to sending them eventually however).

C O N T A C T I N G  T H E  A U T H O R

If you use Guided Reading and like it, please let me know at one of the 
following addresses. If you don’t use GR, I’d like to know why (try to be 
nice). If you hate GR, send $100.00 in cash to my post office box. Here 
are my addresses:

Internet: herren@midd.cc.middlebury.edu
or,
david.herren@f201.n325.z1.fidonet.org

BITnet: herren@midd

Fidonet: David Herren, 1:325/201

Applelink: Herren

SnailMail: Box 324
Middlebury, VT 05753

Ma Bell: (802) 388-3711 ext. 5558 (days)
(802) 388-9867 (nights/weekends)

GMMac: (802) 388-9899
No parity, 8 data bits, 1 stop bit, full duplex (these are recommended)
Acceptable rates (bits per second, a.k.a. baud though incorrectly so)
• 300-2400 CCITT standards
• 9600 v32
• 14,400 HST

Follow all the prompts at log-on and look for the “Sysop’s Top 25” file section for 
the latest versions. Be sure to send me a message letting me know you’ve stopped by. I 
look forward to hearing from you.


